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Contribute Resources

Adobe Contribute @ VSU
Web Services Website

* Training guides, information about installing Contribute, and
Making the initial Connection:

http://www.valdosta.edu/it/eis/systems/webservices/guides/contribute/

* Request new Publisher, Writer, creation of forms, Broken Link
report, etc:

http://www.valdosta.edu/it/eis/systems/webservices/forms/



http://www.valdosta.edu/it/eis/systems/webservices/guides/contribute/
http://www.valdosta.edu/it/eis/systems/webservices/guides/contribute/
http://www.valdosta.edu/it/eis/systems/webservices/guides/contribute/
http://www.valdosta.edu/it/eis/systems/webservices/forms/
http://www.valdosta.edu/it/eis/systems/webservices/forms/
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Address: ‘ about:startpage

Begin Editing
+ Valdosta State University (Production)

= i

‘Website Connection  Blog Connection

Redesigned Adobe TV
u:] Quick tour

Tune in to your online source for expert tutorizls, insight, and inspiration,
u:] Contribute Tutorial

Get started with my website

[] Don't show again
Add a page to my website

Add content to a web page

Finish up with my website
Work with blogs

3

3

3

P Modify a web page
3

3

b Administer a website
3

Troubleshooting
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Contribute Roles

Two Roles Available:

* Writer — make changes to website and send
page for review

* Publisher — make changes to website and send

page for review or publish page live on
website
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Initial Connection to
Contribute Server

Adobe’
nh'...

Contribute CS4
#  Browser: Start Page [__.x : £ New .. l = 'Y © stop E DeSktOp |COﬂ aftel’
' software installation

Address: |cnnnect:ﬁkb:uk.valdusta.edu I

. File Edit View Bookmarks Review Insert Format Table Help | BN ~ ]

Start Page

PAGES

Important: Verify
all people in your
department are on
the same version

In the address bar, type: connect:tiktok.valdosta.edu
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Initial Connection to
Contribute Server

Pleass enber your st pursperord bo connesct Lo the Publishing
Cerver.,

Sarver: hitbps Svaldost s, acy: SO0 contribote
Lleername: | o

Bassword:

e sword
Bafore trusting this server, you should verify ks derdiy.

[ [] Trust this server ]

[ hwe | [ o ][ coem |

Log in: with your Active Directory username and password
(the username/password used to login to your computer)

Check the box: Trust the server
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Initial Connection to
Contribute Server

* Windows SecurityAlert %

e
["l“ I' To help protect your compuler, —— | Firewall haz blocked
zome featwes of thiz program.

Do pou want 1o keep blocking this prog

= Heme  Contiibute
Publsher  Maciomedia, Inc

wfirsdowes: Feveall bt blocked this progearn from sccapling connectons from the

Irtetred of & netvacrk [ pou secogreze the piogram of tust the publither, pou can
unblock & When should | unblock & peoorams

Select: Unblock
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Create a New Page
Using the Template

e oot @i @t B o g Two template levels:

Address: | http: ffwww. valdosta, edu/itfindex.shtml
New Web Page or Blog Entry
Create new web page or blog entry for: Preview: Leve I 1 - M al n P ag e
= y Valdosta State Universi ity (Production) [

#~[q Blank Web Page
Copy of Current Page

—— Level 2 — Pages after
i ? Main Page

q My Computer

Avoid editing colors and
fonts so look stays
O e e consistent

Level 1 template -

Help ] [cv Refresh Templates

Page title:
Select: New....

Select: levell

Descriptive

Long
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Publish or Send Page

. File Edit View Bookmarks Review Insert Format Table Help | B~ (=~
EE] Table =5

InformationTechnologyMain'WebSite{Mew).shiml
H Save for Later | $€ Discard Draf'tl @v Link v Image

Level 1 template:

(@ when you're ready to publish your new page, dick the Publish button on the toolbar. If you want to send your new page to so

Contribute
Visitors to your website will not be able to find this new page until
you add a link to it from an existing page. Do you want to publish

A this page without linking to it?
Publish button

Don’t warn again

[]Don't warn again

Select: Publish button or Send
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New Page — Select Folder

Publish New Page

F e Please enter a filename for this new page. The filename will become part of
1 the page's web address on your website.

Level 1 template:

Page tile: Information Technology Main Web Sit. ..

Filename: | formationTechnologyMainWebSite, shiml | if’ichnnse Folder...
Page expires on: | ChOOSG FOIder

Web address: http:/fwww.valdosta. edu/it/InformationTechnologyMain. ..

[ Publish ][ Cancel
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Choose Folder [‘5_<|

Look in: |J http:/jwww.valdosta.edu/it/ V| ﬁ :j F] Preview:

av =
S5 / 1
cssc

documents New Folder Icon
£as

gis
forms
hallnet
images

labprinting
netwark
palicies

Folder List y New Folder

reports
security
techfee

Level 1 template:

AIOOIrOOCOOOOoomomoD

|

Folder: http:/fwww. valdosta. edujit/

l Select "http:/fwww. valdosta. edu)it/™ ]

Select: appropriate Folder from list or
Select: New Folder icon and type new folder name
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New Folder Name:

Look in; |E| httpe/fwww, valdosta. edu/fitf Vl @' E ﬁ] Preview:
0 av A
[ css il
[ cssc
[ documents
= Short
[ eis
[ forms
5 halnet Lower Case
[ images New Folder
3 labprinting
E'I network Mew folder name: .
B oices | [waing | No Punctuation
[ practice
[ reports
[ security Ok ] [ Cancel ]
8 scary No Spaces
£ ! k2
Folder: http:/fwww.valdosta,edufit/
' Select "http: /fwww. valdosta.edu it/

Note: whether you are creating a new folder or selecting an existing folder,
make sure you press the “Select” button
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New Page — Filename

{ s Please enter a filename for this new page. The filename will become part of
1 the page's web address on your website, F| |e name:

Fage tile: Information Technology Main Web Sit... Short

Filename: | newpage.shiml | llf'i Choose Folder... Lower Case

Page expires an:

No Punctuation

Web address: http: [fwww.valdosta. edu/itinewpage.shiml

No Spaces

[ Puhblish ][ Cancel




@ Browser: Information Technology

&

Draft Console

HOW DO 1.

) Get started with my website
) Add a page to my website

) Add contentto a web page
» Modify a web page

} Finish up with my website
» Work with blogs

} Administer a website

» Troubleshooting

49 publsh | %,_send | (4 save for ater | 3¢ Discaramraft| | Lk " ] Page Properties 5
5z
@ When youre ready to publish your new page, cick the Publish button an the toosar, IF you want to send your nen page t someane before you publh, on the toobsar and sekect teacty

sy M ET—

South Georgia Gollege EntiyP

BlazeNet

Heme = Administrative Offices > Constituent Groups \

STRATEGIC PLANNIN(

Breadcrumb

Planning i a process of identifying, recording, and tracking the progression of our organizational goals. To do this, we utilize several planning
companents at YSU. These components are united with our campus cemmunity through the recently developed University Counci, which serves as a
campus information conduit and an advisory group to the President. The University Council is part of our progression towards a year-round planning
process that embraces creatiity and collaboration.

Our Planning Components
Our Srateaic Planis the guerarching documentthat captures what we hope to accomplish from 3 broad perspeciive. Our planning datsbase assists us
in recording and tracking goals, as well as providing a way to request additional funding for goals thatyour normal operating budgets cannaot support
The Uaster Plan is the document approved through the Board of Regents which outiines our projected campus needs in terms of our physical and
functional relationships through 2014. The Budaet Plan is appraved by Board of Regents for a given fiscal year and includes additional Initiative
Requests supperted by strategicfunds as approved through the Budget Advisory Council (BAC). The Facilies Plan is managed by our recently
developed Facilties Planning Advisory group. This group s responsible for managing the work flow of our physical growth; including requests for
renovations and space usage changes, as well as implementation Haster Plan construction projects. The External Plan refers to the work of the
Division of University Advancement, which coordinates alumni outreach, fundraising, and the University Foundation. Each of these components plays a
crucial partin our overall planning effort &t VSU.

Using the Database
Many peaple will experience university planning by using our planning database to enter goals, request additional monies, and/or update their
progression towards goal completion. New users will wantto review the description of our planning model, which explains how goals at every level in
he university are related backto aur larger Strategic Plan. If you need to know how to enter VP level Goals, Dean/Director level Siratedies, or
Deparimental Action Plans, refer to the Database User's Guide. If you need to enter a requestfor funding beyond your normal operating budgetin order
o accomplish a goal, then refer ta the Initiative User's Guide

Your Rolein Planning
Planning shouldn' be something an organization does once year. Quite to the contrary, planning is a cantinuous process. As such, our plans have to
be fluid and open to change. We have to think collaborafively and creatively to examine what we really need as an organization and why. We have to be
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Level 2 Template

Does not include
Main Menu

Retain
breadcrumb

Save is same as
Level 1 template

Exercise #1
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New Page — Master Template

Copy of Current Page

. File FEdit View Bookmarks Review Insert Format Table Help | B~ (m~

Before clicking
Edit Page button,
go to the File
Menu:

@ Back =) @ Stop @ Refresh @]v Home Pages

Address: | http:/fwww.valdosta.edujitfindex. shiml

New Web Page or Blog Entry

Create new web page or blog entry for; Preview:

= } Valdosta State University (Production)
D Weh Pade
B

Black Web Bac

Copy of Current Page
- helpdesk_hi1
o levell
m level2

:1 My Computer

-New...

-Copy of Current
Page

Create a new web page bazed on the page vou'te currently
browsing.

Draft Console 0

HOW DO I...

» Get started with my website

-Enter a Title

Page title: ‘ New Information Technology Main Wek
» Add a page to my website

» Add content to a web page [ Help ] [ (. Refresh Templates OK. Cancel

b Modifv a web paoe
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Relative Links

LK L I &2 =2 e

Drafts and Create Browse to E-mail File on
Recent Pages  Mew Page Web Page Address My Computer

To insert a Link:

Link text:

Y'eb address [URL):
| hittp: & A valdosta, eduditdindes. shiml |

Uze a web browser to find the page you want to link to.

Search your site far the file you want ta link to.

-Highlight Text

-Right-click and

select Insert Link

-Browse or select
Link

[ Help i[ Advanced w ] I Ok ] [ Cancel
1

Select: Advanced button
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Relative Links

Note: Preview Box

"
Insert Link
@ @ -&If @ (=] Preview: @ Refresh
Drafts and Create Browse to E-mail File on — — H R E F - m b
Recent Pages Mew Page Web Page Address My Computer SRS . u St e
Link text:

path after
www.valdosta.edu
— beginning with
the /

NI =N
ﬁ |
|http:a".-’www.valdosta.edufufficeZDD? I

Uze a web browser to find the page yau want ta link, to.

Lf’i Choose...| Search your zite for the file you want to link to.

Target frame:
-Default (same
window)

o [ o= -New Window

I HREF: | foffice2007 || ’ .
| |
Section anchor: + |l Target frame: | MEEW L
!

’ Help ] [ Advanced ]

(separate window)
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Insert Feature

Format  Table Help |
Table... Ctrl+alt+T

Link b Iltems that can be
Inserted:

Image

SWF

Video

POF Document
Acrobat Connect Link...

Endlosure r

Date... -Tables

Section Anchor... Ctri+alt+a

T v v v

-Links

Horizontal Rule

Line Break Shift+Enter - I m ag es

Spedial Characters r

PayPal +

-Section Anchors

Microsoft Office Document. .
Document As PDF...
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Spell Check Feature

Check Speling...

Bold
Ttalic
Underline
Other

Style
Font
Size

Align
List
Indent
Cutdent

Edit Image

Keywords and Description. ..
Template Properties. ..

Page Properties...

Blog Metadata

nat | Table Help | BN~ @

F7

Cirl+B
Cirl+
Cirl+U

Cirl+Alt+]
Cirl+Alt+[

Ctrl+Alt -+

Ctrl+3

Check Spelling

Word not found in dictionary:

Close

busniess | [ Add
Change to:

Suggestions: A
busyness =
bo'suns E
|:u:|ls ns Ignare Al
bo's'ns
bus_smgs Change All
busings v

rs | BlazeMet

Bbusni intelligence
Lirity, information
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(3 Edit Page ‘ £ New ... ‘ @aback & rove @ Stop [G) Refresh B Home Pages

Address: ‘ http: fjwww. valdosts.edu/itjcss fwks Microso ftOffice 200 7FAQs. shtml

Vsu
SelectaVsU Deparment v

ni & Frienc (Ell Jet

Offices =

Home = Technology » Communications and Training > Microsoft Office 2007 FAQ's

MICROSOFT OFFICE 2007 FAQ'S:

« Whatis the first step | should take if 'm having trouble in Word, Excel, PowerPoint or Access 20077
o In Outlook 2007 | am receiving YSU email in my junk email folder, how do | correct that?

* How should Office 2007 files be saved when using them in WebCT or on a public webpage?
+ How is the fontin the Envelope changed?
Producer work with Office 20072
Wil FrontPage 2003 be removed when Office 2007 has been installed?
= Will Outlook Express be removed when Office 2007 has been installed?
« Can Faculty reproduce the Office 2007 Orientation handouts for student use?

» Can you customize the Ribbon?
= Can you customize the mini-toolbar?
atis OneNote?

P Get started with my website.

. atis Groove?
} Add a page to my website « Whatis InfoPath?
» Add content to a web page = How do vou create .pdffiles in Office 20072
b Modity a web page « How are Office 2007 files saved as HTHL?
» Finish up with my website ; o . . .

What s the first step | should take if I'm having troubie in Word, Excel, PowerPoint or Access 20077

P Work with blogs
» Administer a website ITyour software is not responding the way it used to, for example, if it is slow retrieving files, displays unusual error messages, eic., please make sure
b Troubleshosting you have all the current updates installed and run the Office 2007 Diagnostics Tool. This can help insure your system is running at optimal level. Please

refer to the Installing Office 2007 Updates and Running Diagnastics link for step-by-step instructions.
Backto Top
In Outlook 2007 ['am receiving VSU email in my junk email folder, how do | correct that?

To add @valdosta.edu to your safe senders list, refer to the safe sender link and follow the step-by-step instructions.

Exercise #2
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Images and PDF’

. Etd\t View Bookmarks Review Insert Format Table Help | B~ (=~

. Carl+
pAGES  Open... crl+0 7FAQs.shim
00 Momnmae  Coaio T Dt % File Menu:
.

Actions 3

- Publish from My
Computer -or-

Publish File from My Computer...

Send File from My Computer...

Export...
Prospecti aff | Alumni & Friends |
Page Setup...
Print... crl+p
Print Preview... Mazin Content Section -
" Home = Administrative Offices = Information Technology = Communications and Training = Microgoft
Work Offine -
Drafts 3
) ICROSOFT OFFICE zo007 FA
Recent Pages and Blog Entries 3 = == O m p ute r - O r_
=it o+ - What s the first step | should take if I having trouble in Word, Excel PowerPaint or Access 2
+ In Outlook 2007 | am receiving VSU email in my junk email folder. how do | corect that?
+ How should Office 2007 files be saved when using them in WebCT or on a public webpage?
+ How s the fontin the Envelope changed?
« Will Producer work with Office 20077 - F ro m I m a e I CO n
Draft Console 0 = Will FrontPage 2003 be removed when Office 2007 has been installed?
PP _I + Will Qutlook Express be removed when Office 2007 has been installed?
b Get started with my website Can Faculty [BDFFIULIEE thfa Office 2007 Orientation handouts for student use? O n OOI bar
+ Can you customize the Ribbon?
rpaddanageionyiwen s » Can you customize the mini-toolbar?
» Add content to a web page + What is OneNote?
} Modify a web page + Whatis Groove?
- + Whatls InfoPath?
b AT PR i - How do you creste pdffiles in Office 20072
b Work with blogs + How are Office 2007 files saved as HTHML?
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Descriptive (ALT) Text

Descriptive text is used
by tools that read web
pages to people with

visual disabiles

Deszcription [ALT Text]: | |

Thiz dezcription iz uzed by tools that read “eb pages to people
with vizual dizabilities.

Once image is
inserted changes can

o[ Cores be made to the

Image Properties:

-Right click on image

-Image Properties
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Accessibility

Universal Design — no strobing or flickering
icons on website

Same color palette

.pdf — make sure you list an alternative option
if .pdf cannot be read — list a contact person

Avoid abbreviations and contractions

For more information contact the Access
Office at 245-2498
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M rmat  Table Help |
Table.. | Ctrl+Alt+T
3

Image 3
SWF +
Video 3
PDF Document 3
Acrobat Conmect Link. ..

Endosure 3

Date...

Section Anchor... Cirl+Alt+A

Horizontal Rule
Line Break Shift+Enter
Special Characters 3

PayPal 4

Microsoft Office Document...
Document As PDF...

GIEv

@v Link - Image Table

button on the toolbar. If you want to send your

Prospective Studen

fin Content Section
me = Administrative Offices = Information

MICROSOFT OFFICE

Table

Insert Table

Table size

Mumber of rows:
Murmber of colurns:

Optiong
Table width: & Default width

O Spesiicwidth: [0 |

Border thickness:

Cell padding: I:I

Cell zpacing: I:l

pirels
pixelz between border and content

pixelz between cells

Header
‘-l_l_| ‘---‘ ‘---‘
|| = e |
|| g -
|l = =TT -
Mane Left Top Both

X

o] |

Cancel

From Insert Menu:
- Select Table
_or‘_

From Table Menu:

- Select Insert and
then Table
_Or_

From Table Icon on
toolbar
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Table Formatting

EHEID | B~ Q=
From Table Menu:

Insert k

Delete . - Split Cell

- Sort Table, etc.

Format Table...
Sort Table...

Table Properties. .. Ctrl+shift+T
Table Cell Properties...
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File-Action-Roll Back

-E Edit View Bookmarks Review Insert Format Table Help | B~ &=

Ctrl+M

AQS -
PAGES Open... Ctrl+0 LE S

@ B Browse in Bridge... Cirl+Alt+0 . Send | ) save for Later | %€ Discard Draf‘t] .
5 Ctrl+5 Send >
Ve Actions 3
i Publish Ctrl+Shift+F H
Save for Later Cirl+Shift+ Publish as New Page. .. - ACtlonS
Publish File from My Computer... Discard Draft
Send File from My Computer. ..
Breview in Browser f12 Edit Page Source in External Application Ctrl+shift+E _ RO” BaCk to
Export... I Roll Back to Previous Version... I
Page Setup... PreVIOUS
Print... Ctrl+F .
Print Preview... Main Content Sect Ve rS I O n
Work Offline Home = Admin
Drafts 3
Recent Pages and Blog Entries * thIICR{
Exit Crl+Q . What id

Exercise #3



